
Synfig Studio
Initial Alpha Test Documentation and Tutorial 

About the user interface
When you start Synfig Studio, it will display a splash graphic and boot itself up. After 
it finishes loading, you should see three windows. **INSERT SCREENSHOT 
HERE** The window in the upper left is the toolbox. This is where you can open 
files, change tools, etc. You'll notice that most of the buttons are greyed out--
because there is no file open yet.

The other two windows (one on the bottom, and one to the right) are customizable 
dock dialogs. You can rearrange the contents of these however you wish by simply 
dragging the tab to where you want it. You can even create a new dock dialog by 
dragging a tab out of the dock dialog it was inside of.

If you ever accidently close a dock tab (by dragging it out of the dock dialog, and 
closing the new dock dialog that gets created), no worries. Simply goto the toolbox 
and goto "File->Dialogs", and then click on the name of the dialog you need.

There are a lot of "tabs". If you have no idea what a tab does, simply hold your 
mouse over its icon and a tooltip will pop up describing the name of the tab.

Here are some of the more important ones:

* Layers - This tab shows you the layer hierarchy for the currently selected 
canvas. It also allows you to manipulate these layers.

* Params - This tab will show you the parameters of the currently selected 
layer, (OR, if multiple layers are selected, it shows you only the parameters that the 
selected layers have in common)

* ToolOptions - Shows you any options specific to the currently selected tool
* Navigator - Shows you a thumbnail of what the currently selected Canvas 

looks like. You can also zoom in and move the focus around with this tab.
* History - Shows you the history stack for the current composition. You can 

also edit the actions in history.

If you click the "new composition" button in the toolbar, a new composition will be 
opened and the canvas properties dialog will appear. **Insert screenshot here**

The canvas properties dialog is a mess, I know. I'll have it re-designed into 
something much more comprehendible in the next few days. For now, ignore the 
"Image Area" and "Locks and Links" sections. 



If you click OK, the canvas properties dialog will disappear and you will see the 
Canvas window. This window represents the Root Canvas, not that that means 
much to you at the moment, but that's OK--I'm just trying to show you around.

In the upper left corner of the Canvas Window, you'll see a button with an arrow. If 
you click on this button, the canvas window menu will pop up. (As an aside, if you 
right click in the canvas area and there is not a layer under the mouse position, this 
menu will also appear) So now you know where the menu is in the Canvas 
Window. Good. Everything else should be pretty self-explanatory in the Canvas 
Window. (Explanations on the menu stuff is to come in a sec)

Synfig Concepts
Synfig, like most every other competent graphics program, breaks down individual 
elements of a Canvas into Layers. However, we differ from other programs in two 
major ways:

1) An individual layer in Synfig usually represents a single "Primitive". ie: A 
single region, an outline of a region, an imported JPEG, etc... This allows you to 
have a great deal of flexibility and control. It is not uncommon for a composition to 
have hundreds of layers(organized into a hierarchy for artist sanity of course).

2) A layer can not only composite information on top of the image below it, 
but also distort and/or modify it in some other way. In this sense, Synfig Layers can 
act much like Filters would in PhotoShop. For example, we have a Blur layer, Radial 
blur layer, Spherical Distortion layer, color-correct layer, bevel layer, etc...

Each layer has a set of parameters which determine how it behaves. When you 
click on a layer (either in the canvas window, or in the layer tab), you will see its 
parameters in the param tab.

Tutorial
Lets create something so that we can tweak with it. Now that you have a new 
composition open and the properties dialog is out of the way, go over to the toolbox 
and click on the circle tool(If you don't know which one it is, just mouse over them 
until you find the one with the tooltip that says "circle"). 

The second you click on the circle tool, you should notice that the tool options 
dialog changed. But we'll get to that later.

With the circle tool selected, you can now create circles in the canvas window. This 
pretty much works exactly as you might expect it to. Go ahead and create two (or 
more, if you fancy) circles.



Now go back to the toolbar and click on the "normal" tool (the blue circle with the 
arrow on it). After you do this, click on one of your circles. You will then see a 
bounding box(which is kinda useless at this point in time, but I digress), a green dot 
at the center, and a cyan dot on the radius. Those dots are called DUCKS. If you 
want to modify the circle, grab a duck and drag it around. Easy!

So you can select a layer by clicking on it. If you want to select more than one layer, 
hold down CONTROL while you are clicking--this works in both the canvas and the 
layer tab. Try it!

You can also select multiple ducks. You can do this in several ways. First, you can 
hold down CONTROL and individually click the ducks that you want selected, but 
this can be tedious. However, there is a much faster method--just create a selection 
box by clicking the mouse and dragging it over the area of ducks that you want 
selected. 

Go ahead and select two circles, and select all of their ducks. With several ducks 
selected, moving one duck will move all of the ducks. This behavior is dependent 
on the normal tool. Thus, a more descriptive name for this tool might have been the 
"move" or "translate" tool. 

The Rotate and Scale tools work much like the Normal tool, except in the case 
where you have multiple ducks selected. It is much easier to just try it than read 
about it. Select a few circles, select all of their ducks, and try using the rotate and 
scale tools. 

Note that, unlike the normal tool, the other duck manipulation tools DO have options 
associated with them. If a particular tool isn't doing what you want, take a look in the 
tool options tab to see if it is set up like you want it. 

Now lets try linking. Lets say we always want these two circles to be the same size. 
Select two circles, and then select both of their Radius ducks(the cyan dot). Then 
right click on either duck and a menu will pop up. Click on "Link". Boom. The 
parameters are linked together. You can prove it to yourself by selecting just one of 
the circles and changing its radius--the other one will change as well. Neat stuff, 
eh?

Linking is a fundamental concept in Synfig. You can create links not only between 
ducks, but also between parameters as well by selecting multiple layers, right 
clicking on the parameter in the param tab, and selecting "Link". 

DIGRESSION: This is how outlines are attached to their regions--but I'm getting ahead of myself. At the 
moment, the fundamental power and flexibility of linking in Synfig Core is beyond what Synfig Studio currently 
allows for. This will change in the future. Anyway, back on track...



Lets say you want one of the circles to be a different color. If you look in the toolbox 
below the tools, you'll see the foreground/background color selector, the outline 
width selector, and some other stuff like the default blend method and gradient. The 
foreground/background color widget works exactly as you might expect--you can 
click on the foreground color, and a modest color chooser will appear. Now to can 
change the color pretty easily. 

But sometimes you just want to click on a color and go. This is where the palette 
editor tab comes in. It's functionality isn't quite 100% yet (ie: saving and loading 
custom palettes hasn't been implemented yet), but the default palette is pretty 
decent. Click on the Palette editor tab and have a look--it's the one with the palette-
ish looking icon. Clicking on colors in here will immediately change the default 
foreground color.

That's all great, but we still haven't changed the color of the circle. There are two 
ways to do this. The first way is that you select the circle layer you want to modify, 
goto the params tab and double click on the color parameter--a color selector 
dialog shows up and you just tweak away. But lets say you already got the color you 
wanted selected as the default foreground color. Easy. Just click on the "Fill tool" 
from the toolbox, and then click on the circle in the canvas window. Boom. Circle 
changes color. This works with more than just circles, but we'll get to that in a sec.

Try playing around with the circles for a bit. Muck around with the parameters, and 
see what happens. To get you started, play around with feather a bit.

Ok, circles are all great and stuff, but they are pretty much geometrically inflexible. 
What about shapes? To do this, we use the Bline tool.

When you click on the Bline tool, you will see that the ducks from your currently 
selected layer(if there was one) will disappear, but the layer(s) will still remain 
selected in the layer tab. This is normal. Anything you create in the Bline tool will be 
inserted above the currently selected layer. Keep in mind that if you want to insert a 
shape somewhere, you should select where you want to insert it before you go into 
the Bline tool--changing the selection afterward will automaticly swap you back to 
the normal tool. 

But anyway... Shapes. In Synfig, the construct for describing shapes is called a 
Bline. This is roughly analogous to a "path" in other programs, except that it is 
strictly a hermite spline.

If you take a look at the tool options tab, you'll notice that the first things you see are 
three checkboxes. Make sure that only "Fill" AND "Outline" are checked. 

First, go ahead and click on the "R" button in the lower left corner of the FG/BG color 
widget in the toolbox. This will reset us back to black and white. Also, go ahead and 
set the default line width (right next to the FG/BG widget) to something nice and 



thick--10pt should do the trick.

Clicking with your mouse in the canvas will place vertices. While you are placing a 
vertex, you can drag out its tangent by dragging the mouse. Do this over and over, 
and you construct a Bline.

KEEP IN MIND that during this construction, if you don't like where you placed a 
vertex or a tangent, there is nothing stopping you from just moving it. Honest! If you 
want to remove a vertex, right click on it and delete it. Want to split the tangents? 
Right click on the tangent and hit "split tangents". Want to loop the bline? right click 
on the first vertex and select "loop".

So I assume you got your first Bline laid out like you want it. That's great. But we are 
still in construction mode--the layers haven't been created yet. There are two ways 
to create the layers, 1) just switch to another tool. 2) press the "create" button at the 
bottom of the tool options tab(it's the icon that looks like a gear).

For now, just go ahead and click on the Normal tool because we are done with the 
Bline tool.

Ok, we now have a nice pretty white region with a thick black outline. Notice that 
there are two layers that we have created--the Outline and the Region. Despite the 
fact that they are two separate layers, their vertices parameter has already been 
linked--so you can select either one and move its ducks around and the other one 
will also change.

If you want to manipulate the vertices after you have created the layers, it is very 
easy to do so. Just click on one of the layers and have at it. If you want to remove a 
vertex, right click on it and hit "Remove Item (smart)". Want to insert a point 
somewhere? Right click on the segment where you want to insert something and 
his "Insert item (smart)".

NOTE: The only major difference between this normal editing mode and the 
construction mode is in how you split the tangents--in construction mode you right 
click on the tangent itself. In normal duck editing mode, you must right click on the 
vertex that the tangents are attached to.  This could be considered a usability bug, 
and it will be resolved at some point.

I know what you are thinking. This is going to lead to a mess of layers. And yes, if 
you aren't using the software properly, that is exactly what you will get. But there is a 
way to make this more sane.

We can logically think of the Outline and it's Region as a single "object". Referring to 
it with separate layers is clumsy. What we really want to do is refer to this as a single 
layer that we can move around a bit easier--perhaps give it a name.



To do this, we select both the outline and the region layer and then right click on 
them in the layer tab. A menu will pop up--select encapsulate. You will then see that 
the two layers have been replaced by a new layer with a "box" as an icon called 
"inline canvas". 

We can then treat this layer like any other layer--we can move it around, duplicate it, 
copy and paste it. You'll notice an arrow next to the icon of the box. By clicking on 
this arrow, you can expand the inline canvas to see its contents. 

If you want to change the name of it to something more descriptive, just select the 
layer in the layer tab and click on its label. Then you just edit it in place. You can do 
this for ANY layer, and are strongly encouraged to do so. 

If only for it's organizational capability, encapsulating canvases into inline canvases 
dramatically improves the usability and usefulness of Synfig Studio. But lots of 
programs can do this. What sets Synfig apart from other programs with layer 
hierarchies is the concept of locality. Remember how some layers can muck with 
what is under them, like blur? Well, a layer can only modify the data that it gets from 
directly below it. In other words, if you were to throw a blur layer at the top of that 
inline canvas we just created, the only thing it would blur would be the region and 
outline that are inside of the inline canvas--the circles under it would not be blurred!

Lets try it. Make sure all the circles are under the inline canvas we just created. 
Expand the inline canvas to show its contents, and select the top layer inside of it 
(should be the "Outline" layer). This is where we want to insert the blur. Right click 
on the selected layer and a popup menu will appear. The first item in that popup is 
"New Layer". Inside of the "New Layer" menu, you'll see several categories of layers 
you could create, but what we want is a blur, so goto the Blur category and select 
the "Blur" layer. (so that would be "New Layer->Blurs->Blur")

Well, it blurred... but something is not quite right--the inside edge of the outline is 
now all soft, but it still kinda looks like there is a hard edge on the outside. It is doing 
this because the blend method of the blur defaulted to "composite" (you can change 
the default blend method for new layers from the toolbox). What we want is a blend 
method of "Straight". Just select the blur layer, and change the blend method to 
"straight" in the params tab. 

(NOTE: I will probably change the way that default blend methods are handled in 
the future--as the way it is currently handled seems to only create hassles like this)

Ok, now we have all of the contents of the inline canvas blurred, but everything 
under it is sharp! 

One quick thing to mention before I finish up. You can change the width of an 
outline at each vertex. You do this by selecting the outline layer (NOTE: selecting 
the region layer won't work, you must select the outline layer) and tweaking with the 



width ducks. The only problem is, where are the width ducks? by default, they are 
masked. To toggle width ducks, press ALT-5. You can also see other things to mask 
via the CanvasWindow->View->MaskDucks menu.

That should give you enough of a grasp of the software to be able to figure out more 
stuff on your own.

Other Notes
Synfig Studio has an autorecover feature. If you are working on something that you 
haven't saved for a while and the program crashes, you will not loose more than 5 
minutes of work. Simply restart Synfig studio and it will recover the unsaved 
changes. Unfortunately history isn't recovered yet. That feature comes later.

One thing you may notice is that Synfig Studio is SLOW, making it practically 
unusable on hardware that is over 3 years old. The biggest reason for this is that all 
of the color calculations are done in floating point--because Synfig Studio was built 
from the ground up with High-Dynamic-Range Imaging in mind. HOWEVER, this 
will not be the case forever. 

I have some fairly major re-implementations and optimizations that I am about to 
implement that should quite dramatically improve the performance of Synfig on all 
platforms. My goal is not a 200% speed increase, my goal is at least a 2000% 
speed increase. With the optimizations that I plan to implement, I will be able to 
pipeline operations in such a way that this performance improvement can be 
realized. It should also pave the way to hardware acceleration using todays 
powerful graphics processors, which should yield further performance 
improvements measurable in orders of magnitude.

I think that about does it for now. There is TONS more stuff, and I haven't even 
talked about animation yet. More to follow...


